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Principle 

The Cellavision DM96 is an automated digital cell morphology system.  A stained 
peripheral blood smear is automatically scanned and images are made, stored and 
preclassified ready for a clinical lab scientist to edit and verify classification.  These 
images are archived and may be accessed by anyone with the appropriate security and 
remote viewing computer software. 
 
The Cellavision DM96 is used in place of an optical microscope for most specimens.  
Peripheral blood smears from specimens with results requiring slide review based on 
abnormalities suspected by automated CBC analysis or because a manual differential was 
ordered are analyzed on the Cellavision.  A qualified clinical laboratory scientist views 
all WBC, RBC, and Platelet digital images and edits the classifications if needed.  Results 
are reported using the entries made to the Cellavision screens transferring to the LIS via 
the Remisol middleware software after signing the slide. 
 
Cellavision CM96 operation and features are outlined in this procedure. Refer to the 
complete Cellavision DM 96 User’s Manual, available electronically on the instrument 
help files, and as a book at the bench, for more details.  The information is used in 
conjunction with the following Hematology procedures to complete the differential 
review process. . 
 

 LH 780 Procedure    Technical Procedure #1510 

 LH 780 (Interpretation & Rechecks)  Technical Procedure #1515 

 LH 780 Automated Differential Review Technical Procedure #1516 

 Reporting of Peripheral Blood Morphology Technical Procedure #1140 

 Hemastainer Maintenance and Operation Technical Procedure #1142 

 Normal Peripheral Blood Smear  Technical Procedure #1145 

 Processing Procedure    Technical Procedure #1150 

 Beckman Remisol Middleware  Technical Procedure #1530 

 

Specimen 

A. Collect blood and prepare smears using the Coulter LH instrument or manually, 
according to Processing Procedure #1150. 
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B. Use clean, dry microscope glass slides with clipped or rounded corners to avoid 
glass breakage and shards. 

C. Manual smears are prepared by the wedge technique and should show a gradual 
transition in thickness, ending in a squared or straight edge, without any grainy 
streaks, troughs, ridges, holes or bubbles.  The blood film must be at least 30 mm 
in length, terminating 5-15 mm from the edge.  See illustrations on pages 127-128 
in the Cellavision User’s Manual for examples of acceptable and unacceptable 
smears. 

Equipment and Supplies 

A. Cellavision DM 96 

B. Cellavision Slide Magazines (box of 40): Item No. MA-10012 (Sysmex) 

C. Stage Oil: Item No. MA-10017 (Sysmex) 

D. Bulb, Osram Xenophot HLX 64625 FCR(12V 100W Halogen): Item No. 90190 
(Sysmex) 

E. Immersion Oil (Cargille): Cat. No. 16482 (Purchasing) 

F. Snowcoat beveled slides: Item No. 00373 (Surgipath) 

Daily Quality Control and Instrument Checks  

A. Shut down system once daily before performing maintenance. 

1. Eject any remaining magazines from the system. 

a. Select Eject Magazine in the Tools menu. 

b. Click OK in the dialog box. 

c. The magazine is ejected into the output drawer. 

2. Select Exit in the File menu. 

a. Select Yes at the Do You Want To Quit?  prompt. 

b. Switch off the system computer by pressing the power button located on 
the front of the computer. 
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c. Select OK when the Shut Down dialog box appears. 

d. Switch off the slide scanning unit (SSU) by toggling the rocker switch 
located on the back left side of the SSU and marked with red tape. 

B. Start Up Operator Checks 

1. Verify the following before powering on: 

a. There is enough immersion oil for the day’s analysis. 

b. The input and output drawers are empty. 

c. All hatches are closed. 

d. Maintenance procedures are complete (See Maintenance Section). 

C. Start Up the System 

1. Switch on the slide scanning unit. 

2. Wait until the light green Status Lamp on the slide scanning unit is 
CONTINUOUSLY lit. 

3. Switch on the system computer by pressing the power button. 

4. In the Log On dialog box, type username, password, and select the appropriate 
database to process routine patient smears.   

5. Click OK. 

D. Quality Control – Daily Cell Location Test 

1. Prepare QC smear 

a. Select a blood sample with a WBC count between 7 and 12 thousand/uL. 

b. Prepare a smear and stain it, AFTER the stain has been changed. 

c. Put a QC label on the smear. 

2. Load and process the slide on the Cellavision according to the instructions in 
the Procedure section. 
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3. Perform Cell Location Analysis 

a. When the slide has finished, open Tools/Cell Location. 

b. Select the new slide at the top of the Worklist. 

c. Using the mouse, click on image 1. 

d. Using the mouse and the arrow keys, review all the images belonging to 
the slide and examine them for missed nucleated cells.  WBCs are marked 
with a green box.  Non-WBCs are marked with a blue box. The box must 
be touching the cell but need not surround the cell completely. 

e. Enter the number of missed cells, if any, in the appropriate field. 

f. When all images have been examined, the ratio of cells found vs. total 
cells will be calculated. 

g. The cell location ratio must be > 97%. 

i. If the result is < 97%, repeat with a new slide. 

ii. If it fails again, clean the objectives and repeat again. 

iii. If the cell location ratio still is unacceptable, call for service 

iv. Document the Daily Maintenance and the result of the Cell 
Location Test in the Maintenance Log 

Procedure 

A. Load slides 

1. Load the slides into the magazine with the barcode upwards and at the same 
end as the magazine barcode. 

2. 12 slides can be loaded into a magazine. 

3. The slide positions in the magazine are numbered 1-12 from the bottom up. 

4. The slide in position 1 is processed first. 
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B. Process Slides 

5. Open the input hatch and put the magazines on the conveyer with the barcodes 
up and towards the back of the instrument. 

6. Close the input hatch. 

7. The process starts automatically. 

8. Remove completed magazines from the output drawer.  If the drawer is too 
full, new magazines cannot be processed. 

C. Review Processed Slides. 

1. Select View/Database View 

2. Select the Order ID (barcode number) from either the Worklist or the 
Database by double-clicking on it. 

3. Review WBCs 

a. If performing a manual differential all cells must be classified completely. 

b. WBCs are presented, by class, in galleries. 

c. The WBC gallery that was viewed last is displayed. 

d. Switch to WBC Full Screen (icon with the green mark), One Gallery, Two 
Galleries, or Three Galleries, by clicking on the appropriate icon at the top 
of the screen  

e. ALL unidentified cells must be identified in order to sign a slide. 

f. ALL cell classes, including smudge cells and artifacts, must be “touched” 
by clicking on at least one cell in the class, even if no changes are made, in 
order to complete (sign) a slide. The operator must scroll down to the 
bottom of the page to visualize all cells as well in order to sign a slide. 

g. Reclassify WBCs by: 

i. Dragging and dropping them from one gallery to another. 

ii. Dragging and dropping them from one gallery to WBC or non-
WBC panel. 
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iii. Right-clicking on a cell to reclassify it using the displayed cell 
list. 

iv. More than one cell at a time may be selected and reclassified 
using the following keyboard functions: 

a) Holding down the shift key, click on the first and last 
cells in a group to select all of them, then drag and drop 
or right click to reclassify the cells. 

b) Holding down the control key, click on each cell to be 
reclassified, then drag and drop or right-click to 
reclassify the cells. 

v. If a scan diff is performed and the visual inspection of the 
Cellavision agrees with the Coulter Counter results, Click on 
the Cell Counter Confirm button (the green check mark) to 
suppress the manual differential from the Cellavision and send 
a message to the Remisol to accept the automated differential. 

vi. Move to any gallery screen to add WBC Comments by clicking 
on the WBC Comments button on the lower left side of the 
summary. 

a) Left shift comments, toxic granulation as well as WBC 
morphology comments are added here.  Double click on 
a comment or click and append to bring the comment 
up into the upper comment box to add a comment to a 
sample. 

4. Review RBCs 

a. Click on the RBC tab to view the RBC field. 

b. Analyze RBCs in this view using the zoom mode (magnifying glass icon) 
to enlarge the cells and the scroll mode (hand icon) to move from field to 
field. 

c. The micrometer tool may be used to estimate the diameter of the cells, in 
microns, by clicking it and dragging it into the RBC field.  The 
micrometer is resized along with the RBCs when zooming.  Note:  Normal 
RBCs are 6-8 microns in diameter. 
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d. Characterize the RBC morphology as “Report as Zero-Normal”  or “Use 
characterization” by choosing one of the toggle switches at the upper left 
side of the screen.  Choose the 1, 2, or 3 toggle switch for each 
morphology added for Sl, Md, or Mk.  Occasional or rare options are 
available for a few of the more significant parameters under RBC 
Comments.  They are added as described above in WBC Comments. 

e. There are several WBC parameters noted on the RBC morphology screen 
as they are graded SL, MD, MK as well.  These include Dohle Bodies and 
Hypersegmentation. 

f. Also available on the RBC morphology screen is a trigger to send WBC 
and/or PLT values from the Remisol to the LIS automatically from the 
Cellavision.  

i. Press 1 on WBC/PLT to send both WBC and PLT count over 
to LIS. 

ii. Press 2 on WBC/PLT to send the WBC only over to the LIS. 

iii. Press 3 on WBC/PLT to send the PLT only over to the LIS. 

5. Review Platelets 

a. Click on the Platelet tab to view the platelet overview image. 

b. One of the 9 sub-images of the complete PLT overview image (same 
image as for RBC) is displayed.  To see all 9 sub-images, click on each 
entry field to tab to the next sub-image. 

i. Note:  The overview image corresponds to the area of 8 
microscopic high power fields (HPF) (100x objective and a 22 
mm ocular).   

ii. Click on the Help Lines in the toolbar to display lines drawn 
over the image to facilitate platelet counting. A tic tac toe grid 
is superimposed on the sub-image dividing it into 9 squares. 

iii. Because this view approximates a 100x field the closest, 
quantitation for RBC morphologies can be assessed on this 
screen and reported on the RBC screen by toggling back and 
forth on the RBC and PLT tabs. 
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c. Counting platelets in the overview image. 

i. There are two ways (modes) of performing platelet estimates.  
The platelet estimate is based on the number of PLTs, which 
must be counted manually.  You can choose to count the 
number of PLTs in each grid square (entire displayed square, 
with or without help lines) or to specify and approximate 
number of PLTs per grid square. 

a) Specifying an approximate PLT count per grid square. 

1) Select the Approximate PLTS per grid square 
radio button. 

2) Use the entry fields to view different grid 
squares. 

3) Estimate the average PLT count per grid square 
and type this value in the field. 

b) Counting PLTs per grid square 

1) Select the Count PLTs per grid square radio 
button. 

2) Select the entry fields (divided by help lines) 
and count platelets in the image window and 
type the number in the entry field.  You can use 
tab and shift+tab to move between entry fields. 

d. PLT Result: deriving number 

i. Click Calculate PLT Result in the PLT Count Panel. 

ii. The PLT concentration is displayed, along with a qualitative 
estimate. 

iii. The platelet estimate here is a quantitative number and is used 
only for comparison purposes. 

iv. The platelet estimate may be significantly affected by atypical 
RBC and PLT distributions as well as platelet clumping.  
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e. Reporting platelet estimate 

i. Select Exclude PLT Analysis. 

ii. Plt estimates and Plt morphology comments are added in the 
PLT Comments section of the Platelet screen in the same way 
as WBC and RBC comments. 

iii. When clumping is suspected by abnormal platelet or WBC 
histogram/flags, a low or decreasing (by delta check) platelet 
count, the presence of even one clump may be significant. 
Platelet clumps can be viewed not only on the PLT estimation 
tab but also in the background on the WBC images or in the 
thrombocyte aggregate category on the WBC tab, but also on 
the RBC morphology image as well.  

iv. It is not possible to view the feathered edge on the Cellavision.  
When there is a strong suspicion about clumping, look at the 
feathered edge on a regular microscope.  

6. Partial review of slides on Cellavision. 

a. There are no rules that say all three pieces (WBC, RBC, PLT) of the smear 
review must be performed by the same method (Cellavision vs manual). 

b. If some of the WBC’s are odd looking, review WBC on the scope and 
RBC and PLT on the Cellavision. 

c. If the RBC morphology area is bad while the WBC images are good (they 
are performed separately), do the RBC morphology on the scope and the 
WBC on the Cellavision. 

 

D. Sign Slides (confirms that the differential is complete) 

1. Click Sign.  The Sign Slide dialog appears. 

2. Enter User name and Password.  The Username is Cellavision and the 
password is user. 

3. Click OK to sign both the slide and the order and transmit the data to the 
Remisol and from there to the LIS. 

4. When the slide is signed, it may printed. 
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5. If multiple slides are being used for a differential, each slide must be signed 
individually before they are merged; then sign the order after merging. 

6. Note:  No slide data can be changed after signing.  Data can be added however 
and transmitted to the Remisol after signing by adding the desired comments 
in the appropriate areas then going to report view and choosing Send to LIS. 
A slide and its results can only be deleted by someone with Administrator 
access (supervisor, specialist). 

Maintenance 

Note:  Shut down the system before performing maintenance procedures.  Start up to 
resume operation. 

A. Daily Maintenance 

1. Shut down system 

a. Eject any remaining magazines from the system. 

b. Select Exit in the file menu. 

c. Switch off the system computer. 

d. Switch off the slide scanning unit (SSU). 

2. Open the main hatch. 

3. Clean the XY stage from immersion oil with a gauze pad or Kimwipe. 

4. Close the main hatch. 

5. Caution:  To avoid wearing, only clean the stage barcode when dirty. 

6. Start the system if all maintenance is complete. 

B. Weekly Maintenance 

1. Clean Objectives 

a. Shut down system as in Daily Maintenance. 

b. Open the main hatch. 
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c. Clean the lens on all objectives by wiping them gently with lens paper.  
Always use a fresh lens paper to avoid oil contamination.  To reach all 
lenses, carefully turn the objective turret. 

d. Apply the following steps only on the high power oil objectives.  Put a 
drop of lens cleaner on a piece of crumbled lens paper.  Do not use an 
excessive amount. 

e. Wipe the objective once to remove most of the oil.  Do not use a circular 
motion to clean lenses as this increases the risk of scratching the surface. 

f. Take a new piece of lens paper and put a drop of lens cleaner in the 
middle. 

g. Place the lens paper over the objective and drag the wet lens paper away 
from the objective. 

h. Repeat steps one time. 

C. Monthly Maintenance 

1. Clean Slide Guides 

a. Clean the slide guides carefully to remove any glass shards or particles. 

b. Apply one drop of stage oil at two positions marked in red, according to 
the photo on page 85 of the User’s manual. 

2. Bulb Exchange 

a. Switch off the slide scanning unit (SSU) and wait for the lamp housing 
and lamp bulb to cool before touching. 

b. Do not touch the new bulb with bare hands. 

c. Loosen the 2 non-detachable screws, which hold the lamp hatch, about 
half a turn counter clockwise, using a 3 mm Allen key. 

d. Remove the hatch by pulling it outwards and then upwards. 

e. Loosen the non-detachable screw of the lamp house cover using a 3 mm 
Allen key. 

f. Lift and remove the cover of the lamp house. 
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g. Press the bulb clamping levers and gently withdraw the old bulb from the 
lamp housing. 

h. Press the bulb clamping levers and fully insert the bulb pins into the pin 
holes. 

i. Gently release the bulb clamping levers to their original position to secure 
the bulb. Withdraw the old bulb from the lamp housing. 

j. Press the bulb clamping levers to their original position to secure the bulb. 

k. Refit the lamp house cover. 

l. Tighten the screw of the lamp house cover. 

m. Refit the lamp hatch. 

n. Tighten the screws of the lamp hatch. 

D. As Needed Maintenance 

1. Immersion Oil Maintenance 

a. Open the main hatch. 

b. Remove the screw cap from the oil canister. 

c. Fill with immersion oil but do not fill higher than the black line. 

d. Clean any spillage with a gauze pad or a Kimwipe. 

e. Refit the screw cap, leaving it loose for venting. 

f. Close the main hatch. 

E. Document maintenance in the Maintenance Log. 

Database Archive 

A. Archiving must be done by one of the specialists since the Cellavision database 
resides on the network server. 

B. Log into Cellavision computer with personal Citrix password. 

C. Open Cellavision software. 
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D. Go to Tools/Archive 

E. Follow the Archive Wizard instructions. 

F. Archive settings: 

1. Archive settings are established in Tools/Settings/Archive and may be 
changed by a Cellavision administrator only, if needed. 

2. Current archive settings are: 

3. Keep locally at least 30 days. 

4. Warn when candidates reach 500 signed orders. 

5. Archive to hsimages01\Cellavision\Archive. 

G. Complete explanations about archiving are in the Cellavision DM 96 Training 
Manual pages 46-49 and in the User’s Manual pages 79-81.   

Troubleshooting 

A. Troubleshooting Charts -Cellavision DM 96 User’s manual pages 91-105. 

B. Slide Transport Jam – User’s Manual pages 106-107. 

C. Magazine Transport Jam – User’s Manual pages 107-109. 

References 

Cellavision DM 96 User’s Manual Software Version 1.6 (Instrument Help Files and 
paper copy) 

Cellavision DM 96 Training Manual (paper copy only) 
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	A. Collect blood and prepare smears using the Coulter LH instrument or manually, according to Processing Procedure #1150.
	B. Use clean, dry microscope glass slides with clipped or rounded corners to avoid glass breakage and shards.
	C. Manual smears are prepared by the wedge technique and should show a gradual transition in thickness, ending in a squared or straight edge, without any grainy streaks, troughs, ridges, holes or bubbles.  The blood film must be at least 30 mm in leng...
	A. Cellavision DM 96
	B. Cellavision Slide Magazines (box of 40): Item No. MA-10012 (Sysmex)
	C. Stage Oil: Item No. MA-10017 (Sysmex)
	D. Bulb, Osram Xenophot HLX 64625 FCR(12V 100W Halogen): Item No. 90190 (Sysmex)
	E. Immersion Oil (Cargille): Cat. No. 16482 (Purchasing)
	F. Snowcoat beveled slides: Item No. 00373 (Surgipath)
	A. Shut down system once daily before performing maintenance.
	1. Eject any remaining magazines from the system.
	a. Select Eject Magazine in the Tools menu.
	b. Click OK in the dialog box.
	c. The magazine is ejected into the output drawer.

	2. Select Exit in the File menu.
	a. Select Yes at the Do You Want To Quit?  prompt.
	b. Switch off the system computer by pressing the power button located on the front of the computer.
	c. Select OK when the Shut Down dialog box appears.
	d. Switch off the slide scanning unit (SSU) by toggling the rocker switch located on the back left side of the SSU and marked with red tape.


	B. Start Up Operator Checks
	1. Verify the following before powering on:
	a. There is enough immersion oil for the day’s analysis.
	b. The input and output drawers are empty.
	c. All hatches are closed.
	d. Maintenance procedures are complete (See Maintenance Section).


	C. Start Up the System
	1. Switch on the slide scanning unit.
	2. Wait until the light green Status Lamp on the slide scanning unit is CONTINUOUSLY lit.
	3. Switch on the system computer by pressing the power button.
	4. In the Log On dialog box, type username, password, and select the appropriate database to process routine patient smears.
	5. Click OK.

	D. Quality Control – Daily Cell Location Test
	1. Prepare QC smear
	a. Select a blood sample with a WBC count between 7 and 12 thousand/uL.
	b. Prepare a smear and stain it, AFTER the stain has been changed.
	c. Put a QC label on the smear.

	2. Load and process the slide on the Cellavision according to the instructions in the Procedure section.
	3. Perform Cell Location Analysis
	a. When the slide has finished, open Tools/Cell Location.
	b. Select the new slide at the top of the Worklist.
	c. Using the mouse, click on image 1.
	d. Using the mouse and the arrow keys, review all the images belonging to the slide and examine them for missed nucleated cells.  WBCs are marked with a green box.  Non-WBCs are marked with a blue box. The box must be touching the cell but need not su...
	e. Enter the number of missed cells, if any, in the appropriate field.
	f. When all images have been examined, the ratio of cells found vs. total cells will be calculated.
	g. The cell location ratio must be > 97%.
	i. If the result is < 97%, repeat with a new slide.
	ii. If it fails again, clean the objectives and repeat again.
	iii. If the cell location ratio still is unacceptable, call for service
	iv. Document the Daily Maintenance and the result of the Cell Location Test in the Maintenance Log



	A. Load slides
	1. Load the slides into the magazine with the barcode upwards and at the same end as the magazine barcode.
	2. 12 slides can be loaded into a magazine.
	3. The slide positions in the magazine are numbered 1-12 from the bottom up.
	4. The slide in position 1 is processed first.

	B. Process Slides
	5. Open the input hatch and put the magazines on the conveyer with the barcodes up and towards the back of the instrument.
	6. Close the input hatch.
	7. The process starts automatically.
	8. Remove completed magazines from the output drawer.  If the drawer is too full, new magazines cannot be processed.

	C. Review Processed Slides.
	1. Select View/Database View
	2. Select the Order ID (barcode number) from either the Worklist or the Database by double-clicking on it.
	3. Review WBCs
	a. If performing a manual differential all cells must be classified completely.
	b. WBCs are presented, by class, in galleries.
	c. The WBC gallery that was viewed last is displayed.
	d. Switch to WBC Full Screen (icon with the green mark), One Gallery, Two Galleries, or Three Galleries, by clicking on the appropriate icon at the top of the screen
	e. ALL unidentified cells must be identified in order to sign a slide.
	f. ALL cell classes, including smudge cells and artifacts, must be “touched” by clicking on at least one cell in the class, even if no changes are made, in order to complete (sign) a slide. The operator must scroll down to the bottom of the page to vi...
	g. Reclassify WBCs by:
	i. Dragging and dropping them from one gallery to another.
	ii. Dragging and dropping them from one gallery to WBC or non-WBC panel.
	iii. Right-clicking on a cell to reclassify it using the displayed cell list.
	iv. More than one cell at a time may be selected and reclassified using the following keyboard functions:
	a) Holding down the shift key, click on the first and last cells in a group to select all of them, then drag and drop or right click to reclassify the cells.
	b) Holding down the control key, click on each cell to be reclassified, then drag and drop or right-click to reclassify the cells.

	v. If a scan diff is performed and the visual inspection of the Cellavision agrees with the Coulter Counter results, Click on the Cell Counter Confirm button (the green check mark) to suppress the manual differential from the Cellavision and send a me...
	vi. Move to any gallery screen to add WBC Comments by clicking on the WBC Comments button on the lower left side of the summary.
	a) Left shift comments, toxic granulation as well as WBC morphology comments are added here.  Double click on a comment or click and append to bring the comment up into the upper comment box to add a comment to a sample.



	4. Review RBCs
	a. Click on the RBC tab to view the RBC field.
	b. Analyze RBCs in this view using the zoom mode (magnifying glass icon) to enlarge the cells and the scroll mode (hand icon) to move from field to field.
	c. The micrometer tool may be used to estimate the diameter of the cells, in microns, by clicking it and dragging it into the RBC field.  The micrometer is resized along with the RBCs when zooming.  Note:  Normal RBCs are 6-8 microns in diameter.
	d. Characterize the RBC morphology as “Report as Zero-Normal”  or “Use characterization” by choosing one of the toggle switches at the upper left side of the screen.  Choose the 1, 2, or 3 toggle switch for each morphology added for Sl, Md, or Mk.  Oc...
	e. There are several WBC parameters noted on the RBC morphology screen as they are graded SL, MD, MK as well.  These include Dohle Bodies and Hypersegmentation.
	f. Also available on the RBC morphology screen is a trigger to send WBC and/or PLT values from the Remisol to the LIS automatically from the Cellavision.
	i. Press 1 on WBC/PLT to send both WBC and PLT count over to LIS.
	ii. Press 2 on WBC/PLT to send the WBC only over to the LIS.
	iii. Press 3 on WBC/PLT to send the PLT only over to the LIS.


	5. Review Platelets
	a. Click on the Platelet tab to view the platelet overview image.
	b. One of the 9 sub-images of the complete PLT overview image (same image as for RBC) is displayed.  To see all 9 sub-images, click on each entry field to tab to the next sub-image.
	i. Note:  The overview image corresponds to the area of 8 microscopic high power fields (HPF) (100x objective and a 22 mm ocular).
	ii. Click on the Help Lines in the toolbar to display lines drawn over the image to facilitate platelet counting. A tic tac toe grid is superimposed on the sub-image dividing it into 9 squares.
	iii. Because this view approximates a 100x field the closest, quantitation for RBC morphologies can be assessed on this screen and reported on the RBC screen by toggling back and forth on the RBC and PLT tabs.

	c. Counting platelets in the overview image.
	i. There are two ways (modes) of performing platelet estimates.  The platelet estimate is based on the number of PLTs, which must be counted manually.  You can choose to count the number of PLTs in each grid square (entire displayed square, with or wi...
	a) Specifying an approximate PLT count per grid square.
	1) Select the Approximate PLTS per grid square radio button.
	2) Use the entry fields to view different grid squares.
	3) Estimate the average PLT count per grid square and type this value in the field.

	b) Counting PLTs per grid square
	1) Select the Count PLTs per grid square radio button.
	2) Select the entry fields (divided by help lines) and count platelets in the image window and type the number in the entry field.  You can use tab and shift+tab to move between entry fields.



	d. PLT Result: deriving number
	i. Click Calculate PLT Result in the PLT Count Panel.
	ii. The PLT concentration is displayed, along with a qualitative estimate.
	iii. The platelet estimate here is a quantitative number and is used only for comparison purposes.
	iv. The platelet estimate may be significantly affected by atypical RBC and PLT distributions as well as platelet clumping.

	e. Reporting platelet estimate
	i. Select Exclude PLT Analysis.
	ii. Plt estimates and Plt morphology comments are added in the PLT Comments section of the Platelet screen in the same way as WBC and RBC comments.
	iii. When clumping is suspected by abnormal platelet or WBC histogram/flags, a low or decreasing (by delta check) platelet count, the presence of even one clump may be significant. Platelet clumps can be viewed not only on the PLT estimation tab but a...
	iv. It is not possible to view the feathered edge on the Cellavision.  When there is a strong suspicion about clumping, look at the feathered edge on a regular microscope.


	6. Partial review of slides on Cellavision.
	a. There are no rules that say all three pieces (WBC, RBC, PLT) of the smear review must be performed by the same method (Cellavision vs manual).
	b. If some of the WBC’s are odd looking, review WBC on the scope and RBC and PLT on the Cellavision.
	c. If the RBC morphology area is bad while the WBC images are good (they are performed separately), do the RBC morphology on the scope and the WBC on the Cellavision.


	D. Sign Slides (confirms that the differential is complete)
	1. Click Sign.  The Sign Slide dialog appears.
	2. Enter User name and Password.  The Username is Cellavision and the password is user.
	3. Click OK to sign both the slide and the order and transmit the data to the Remisol and from there to the LIS.
	4. When the slide is signed, it may printed.
	5. If multiple slides are being used for a differential, each slide must be signed individually before they are merged; then sign the order after merging.
	6. Note:  No slide data can be changed after signing.  Data can be added however and transmitted to the Remisol after signing by adding the desired comments in the appropriate areas then going to report view and choosing Send to LIS. A slide and its r...

	A. Daily Maintenance
	1. Shut down system
	a. Eject any remaining magazines from the system.
	b. Select Exit in the file menu.
	c. Switch off the system computer.
	d. Switch off the slide scanning unit (SSU).

	2. Open the main hatch.
	3. Clean the XY stage from immersion oil with a gauze pad or Kimwipe.
	4. Close the main hatch.
	5. Caution:  To avoid wearing, only clean the stage barcode when dirty.
	6. Start the system if all maintenance is complete.

	B. Weekly Maintenance
	1. Clean Objectives
	a. Shut down system as in Daily Maintenance.
	b. Open the main hatch.
	c. Clean the lens on all objectives by wiping them gently with lens paper.  Always use a fresh lens paper to avoid oil contamination.  To reach all lenses, carefully turn the objective turret.
	d. Apply the following steps only on the high power oil objectives.  Put a drop of lens cleaner on a piece of crumbled lens paper.  Do not use an excessive amount.
	e. Wipe the objective once to remove most of the oil.  Do not use a circular motion to clean lenses as this increases the risk of scratching the surface.
	f. Take a new piece of lens paper and put a drop of lens cleaner in the middle.
	g. Place the lens paper over the objective and drag the wet lens paper away from the objective.
	h. Repeat steps one time.


	C. Monthly Maintenance
	1. Clean Slide Guides
	a. Clean the slide guides carefully to remove any glass shards or particles.
	b. Apply one drop of stage oil at two positions marked in red, according to the photo on page 85 of the User’s manual.

	2. Bulb Exchange
	a. Switch off the slide scanning unit (SSU) and wait for the lamp housing and lamp bulb to cool before touching.
	b. Do not touch the new bulb with bare hands.
	c. Loosen the 2 non-detachable screws, which hold the lamp hatch, about half a turn counter clockwise, using a 3 mm Allen key.
	d. Remove the hatch by pulling it outwards and then upwards.
	e. Loosen the non-detachable screw of the lamp house cover using a 3 mm Allen key.
	f. Lift and remove the cover of the lamp house.
	g. Press the bulb clamping levers and gently withdraw the old bulb from the lamp housing.
	h. Press the bulb clamping levers and fully insert the bulb pins into the pin holes.
	i. Gently release the bulb clamping levers to their original position to secure the bulb. Withdraw the old bulb from the lamp housing.
	j. Press the bulb clamping levers to their original position to secure the bulb.
	k. Refit the lamp house cover.
	l. Tighten the screw of the lamp house cover.
	m. Refit the lamp hatch.
	n. Tighten the screws of the lamp hatch.


	D. As Needed Maintenance
	1. Immersion Oil Maintenance
	a. Open the main hatch.
	b. Remove the screw cap from the oil canister.
	c. Fill with immersion oil but do not fill higher than the black line.
	d. Clean any spillage with a gauze pad or a Kimwipe.
	e. Refit the screw cap, leaving it loose for venting.
	f. Close the main hatch.


	E. Document maintenance in the Maintenance Log.
	A. Archiving must be done by one of the specialists since the Cellavision database resides on the network server.
	B. Log into Cellavision computer with personal Citrix password.
	C. Open Cellavision software.
	D. Go to Tools/Archive
	E. Follow the Archive Wizard instructions.
	F. Archive settings:
	1. Archive settings are established in Tools/Settings/Archive and may be changed by a Cellavision administrator only, if needed.
	2. Current archive settings are:
	3. Keep locally at least 30 days.
	4. Warn when candidates reach 500 signed orders.
	5. Archive to hsimages01\Cellavision\Archive.

	G. Complete explanations about archiving are in the Cellavision DM 96 Training Manual pages 46-49 and in the User’s Manual pages 79-81.
	A. Troubleshooting Charts -Cellavision DM 96 User’s manual pages 91-105.
	B. Slide Transport Jam – User’s Manual pages 106-107.
	C. Magazine Transport Jam – User’s Manual pages 107-109.

